@Tl‘aining—ﬂ”ad@rg Installation Manual

Introduction

In order to cater for everyone with differing levels of computer knowledge, this guide goes
into a lot of detail and therefore looks rather large. It should only take a few minutes to

complete the installation and the steps are straight forward, so don’t panic or be put off with
the 25 pages.

If you have difficulties please email: info@trainingtraders.com
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1. Downloading the Software

After your purchase you will receive an email from ‘alice@trainintraders.com’.
Alice is an automated delivery service, please do not reply to the email, any questions should

be sent to info@trainintraders.com.

The email from Alice contains a link to download the software from. Click on the link and
the software will download.

Attachments:  pataFile.dat (319 6)

Hi Alice
Thank yvou for purchasing the Training Traders Software.

Download the software from:

nttp://www.trainingtraders.com/Multimedia/software/TT SOFIWARE V3.

m
"
11

You will be contacted shortly to help with the setup.

Save the attached (DataFile.dat) in your C:\II_Syscem folder.
Please contact: infoftrainingtraders if you reguire assistance.
Kind Regards

Alice.

Depending upon the web browser files are downloaded differently, usually to a ‘download’
folder. The example below is from Firefox.

| Opening TT_SOFTWARE_V3.exe R

You have chosen to open

® | TT_SOFTWARE_V3.exe
which is a: Binary File
from: http://www.trainingtraders.com

Would you like to save this file?

= - |
Save File { Cancel }

Note: Some antivirus software blocks executable files. If you have an issue, turn off your
antivirus, download the file then turn your antivirus back on.
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Locate the downloaded file (often the browser automatically displays the download folder).
Double click on the file to run it.

@) Downloads = = S
TT_SOFTWARE_V3(2).exe 1315
161 MB — trainingtraders.com

[_C_Iear List ’ Search e

The software is in a self extracting zip which creates the folder C:\TT_system to hold the
software. It is vital that this folder has this name and location, so do not change the setting.

- I 11‘ | 1¢
WinZip Self-Extractor - TT_SOFTWARE_V3.exe X

T
To unzip all files in TT_SOFTWARE_V3.exe to the l Unzip ' |
specified folder press the Unzip button. ——— | kL
’ Run WinZip I —

Unzip to folder: —_—

CATT_System Browse... ’ l Close ‘

V| Ovenrarite files without prompting l About '

| Hep |

\ A’
Click on the Unzip button.
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Once the Unzip is done click on the Close button.

™ 161
[ WinZip Self-Extractor - TT_SOFTWARE V3.exe e S
To unzip all files in TT_SOFTWARE_V3.exe to the .
specffied folder press the Unzip button.
Unzip to folder:
CATT System| Bowse.. | [ Close |

(V| Overarite files without prompting ot

EE
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2. Check TT_System folder and PC configuration

Check that the TT System folder is correctly added on you C: drive (C:\TT_System).

~7 » Computer » COMPAQ (C)

Organize v Open Include in library v Share with ¥ Burn Compatibility files New folde
9 - VP Y P ty

¢ Favorites Name 2 Date modified Type
Bl Desktop _Backup 09,09 File folde
& Downloads Perflogs 14/0 0 File folder
- Recent Places Program Files 07/1 File folde
Program Files (x86) 07/1 File folde
- Libraries Store 0
| Documents SWSETUP
&' Music TT_System
&= Pictures Users
B Videos Windows
.md

Double click on the folder to open it.

» Computer » COMPAQ(C:) » TT System »

Organize v Include in library v Sharewith v Bum New folder
¢ Favorites Dat=s -
Bl Desktop SetupFiles

# Downloads TT_LongTerm_v3.wsp
. Recent Places | TT_ShortTerm_v3.wsp

% TTDLL3.dIl

-9 Libraries %, TTDLL3_64.dIl
< Documents

@' Music

&=/ Pictures

B videos

Double click on the ‘SetupFiles’ folder to enter it.
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There are 32 bit and 64bit version of Windows and Multicharts, we have included setup files
for 32 bit and 64 bit versions. Double click on the ‘Setup Check’ file.

- TS 2=
@Ui » Computer » COMPAQ (C:) » TT_ System » SetupFiles »

Organize v Include in library v Share with v Burn New folder
Favorites L S B
B Desktop Multicharts
& Downloads Multicharts_64bit 08/12/201213:1
Recent Places %) Setup_Check
. Libraries

| Documents

@ Music

The Setup Check will tell you which version of windows you have installed and which
version of Multicharts (if any).

& C:\Windows\system32\cmd.exe ﬁ ; N

I\NIT_System\SetupFiles>echo OFF

raining Traders Setup Check

“"Windows 64bit version"

ulticharts NOT FOUND. please install.

Press any key to continue . . .

[
‘Ehan::-
‘}:hart:_ﬁdblt
|}

‘_Cher:k
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If you have Windows 64bit we recommend using Multicharts 64bit. The next few steps go
through installing Multicharts 64 bit. If you already have Multicharts installed please jump to
section 3.

Double click on the ‘Multicharts 64bit’ folder to enter it.

. » Computer » COMPAQ (C:) » TT_ System » SetupFiles »

Organize v 4 Open Include in library « Share with v Burn New folder
) Favorites Name Date modified Type
Desktop Multicharts 08/12/201213:11 File fold
& Downloads Multicharts_64bit 08/12/201213:11 File fold
| Recent Places @) Setup_Check 29/11/2012 16:08 Window
. Libraries

< Documents
-j‘: Muicie

Double click on the ‘multicharts.8.0.x64’ file to start the Multicharts install.

» Computer » COMPAQ (C:) » TT_ System » SetupFiles » Multicharts_64bit

Organize v @ Open Burn New folder

E £ Name Date modified Type Si:
- Favorites y
B Desktop J?jj multicharts.8.0.x64 15/11/2012 09:45 Application
& Downloads || TT_Software_v3_64 29/11/2012 09:06 SEF File
= Recent Places
- Libraries
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Follow the onscreen instructions to install Multicharts.

» Computer » COMPAQ(C:) » TT System » SetupFiles » Multicharts 64bit

Organize ¥ [ 5 MultiCharts64 - Setup Wizard =
¢ Favorites i 2
B Desktop Welcome to the MultiCharts64 Setup A

Wizard
& Downloads
. Recent Places
The Setup Wizard willinstal MultCharts54 on your
computer, Chck Next to continue or Cancel to exit the

-4 Libraries Setup Wizard.
+| Documents
& Music .
& Pictures
H videos
- A
MULTIC!
1% Computer Raisng The Trading andard

&, compaQ (C)
s FACTORY_IM
My Web Sites

€ Network

» Computer » COMPAQ (C:) » TT System » SetupFiles » Multicharts 64bit

o) E—J MultiCharts64 - Setup Wizard = =
Install MultiCharts64 8.0.5622.401 c
The Setup Wizard is ready to begn the Complete installaton
P w 1 ¥y ol plete i MuLT h
sads
Places

Click Install to begin the installation. If you want to review or change any of your
installation settings, dick Back. Click Cancel to exit the wizard.

1ents
= V| Compile All Uncompied Studies
Select the desired Desktop customization settings below:
or V| Add the MultiCharts64 shortcuts to my Desktop
8Q(C) V] Add the MultiCharts64 shortcuts to my Quick Launch Bar
RY_IM{ |
b Sites | |

Back [ Insal ][ cancel
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After Multicharts is installed you will have a number of icons (shortcuts) on your desktop.
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3. Saving the DataFile

Go to the email from alice@trainingtraders.com and save the attached file in the TT System
folder (C:\TT System).

AT 08 g s e . A 201 g A St e

Subject: TT Software Alice (o
Attachments:  DatsFile.dat (319 8)

Hi Alice
Thank you for purchasing the Training Traders Software.

Download the software from:
nttp://www.trainingtraders.com/Multimedia/software/IT SOFTWARE V3.exe.

You will be contacted shortly to help with the setup.
Save the attached (DataFile.dat) in your C:\TT_System folder.
Please contact: info@trainingtraders if you require assistance.

Kind Regards

Alice.

Different email clients save attachments in different ways, this example is for ‘Outlook’.
Right click on the attachment and select ‘Save As’

! Save Attachment ? Y
¥
1 Savein: | | TT_System v &~ & ¥ £ E - Tools~
[ Name Date modified Type Size
?ﬁ, SetupFiles
History €| TT_LongTerm_v3
€ TT_ShortTerm_v3
"} /% TTDLL3.dlI
% TTDLL3_64.dll

My Documents

o
m
’a
g
h=l

[x)

Favorites

S Vv Ly L oy VvoLr Lr Lr \AY

== Flename:  [DataFie.dat ~| Save |
My Network
Places Save as type: IAII Files _:| Cancel

[l
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It is vital that the ‘DataFile.dat’ is save in C:\TT System folder.

» Computer » COMPAQ (C:) » TT_ System »

Organize v Include in library v Share with v Burn New folder
X Favorites Name : Date modified Type
B Desktop SetupFiles 08/12/201213:11 File folder
& Downloads __| DataFile.dat 08/12/201213:35 DAT File
= Recent Places € TT_LongTerm_v3 05/12 MultiCharts
€| TT_ShortTerm_v3 05/12/2 7 MultiCharts
- Libraries %) TTDLL3.dII 29/11/2012 09:11 Application
}\ Decuments %) TTDLL3_64.dll 28/11/201219:49 Application
J Music
=/ Pictures
¥ videos
= -
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4. Importing the Training Traders software

The Training Traders software is imported using the Multicharts Power Language Editor
which can be started by double clicking on the desktop icon or from the Windows start menu.

ultiCharts...
owerlLang...

HP
LightScribe Direct Disc Labeling

Maintenance Training Traders
Microsoft Office
Microseft Office Tools Documents

Microsoft SQL Server 2005

Microzoft SQL Server 2008 Pictures
Microsoft Visual Studio 2008
Microsoft Windows SDK v6.0A
Microsoft Works

Music

Mozilla Firefox Games

MultiCharts LMAX
MultiCherts64
4| 3D Optimization Charts

Computer

Control Panel
| Logs

L MultiCharts64
s | Portfolic Backte
/=] PowerLanguage Editor Default Programs

Devices and Printers

«&7] QuoteManager Help and Support
Back
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Once the Power Language Editor is running, go to the ‘File’ menu and select
‘Import Read Only’.

File | View Compile Tools Help

New... Ctrl+N
Open... Ctrl+0
Import... Ctrl+I

Ctrl+E

Import Read-Only... Ctrl+M
Export Read-Only...

Print Setup...
Exit Alt+X

Go to the ‘C:\TT_System\SetupFiles’ folder and select the appropriate folder to match the
version of Multicharts you have installed.

— - ~
& Select files X
Lookin: SetupFiles - 02 R
= Name ’ Date modified Type
g Multicharts 08/12/201213:11 File folder
Recentplaces Multicharts_64bit 08/12/20121311 File folder
Desktop
=
Libraries
Computer
Tt
N ,
Network
File name: v Open
Files of type: | SEF files (".sef) vj [ Cancel ‘
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Select the TT Software v3 64 file (or TT Software v3 for the 32 bit version).

£ Select files

Look in: Multicharts_64bit

I Name

’;/" _ TT_Software_v3_64
Recent Places

=
Desktop

=l
Libraries

A

|

Computer

< |

File name:

TT_Software_v3_64 »

- 02 E
Date modified
29/11/2012 09:06

Type
SEF File

m " »

Files of type:

| SEFfiles (sef) v

The software import will start. Click on ‘OK’ to confirm.

= Study Type

V| Function 54 (34) V| Indicator 5 (5) (V] Signal 2 (2)
Select script(s) to import:

Name Type Archive File =
vl L&]average(meran;e Function CATT_System\SetupFiles\Multicharts_64bit\T
V| [&Elavg Function C:A\TT_System\SetupFiles\Mutticharts_64bit\T =
V] [Elavefe Function C:\TT_System\SetupFiles\Multicharts_64bit\T
V] [Elbamum Function C:\TT_System\SetupFiles\Mulicharts_64bit\T
[V [ checkorbreak Function CATT_System\SetupFiles\Mulicharts_64bit\T
V| [ clean Function CATT_System\SetupFiles\Multicharts_64bit\T
| [&] countbars Function C:ATT_System\SetupFiles\Mutticharts_64bit\T
| [#] dateadd Function CATT_System\SetupFiles\Mutticharts_64bit\T
| [Alendsession Function CATT_System\SetupFiles\Mutticharts_64bit\T
V| [Al entriesallowed Function CATT_System\SetupFiles\Multicharts_64bit\T
V| [l extremevalues Function C:\TT_System\SetupFiles\Multicharts_64bit\T
V] [Efailonbar Function C:\TT_System\SetupFiles\Multicharts_64bit\T
[¥] & failonbarprevday Function C:\TT_System\SetupFiles\Multicharts_64bit\T
[V] A fixentrytype Function C:\TT_System\SetupFiles\Multicharts_64bit\T
V| [%] gapfillreversed Function C:\TT_System\SetupFiles\Multicharts_64bit\T
V| % getmomentumpush Function C:\TT_System\SetupFiles\Mutticharts_64bit\T
V| [ getnamowsess Function CATT_System\SetupFiles\Mutticharts_64bit\T
V| [A] getnumsesscounter Function C:\TT_System\SetupFiles\Multicharts_64bit\T
V] [£] getnumsessions Function C:\TT_System\SetupFiles\Multicharts_64bit\T

£ Function C\TT_System\SetupFiles\Multicharts_64bit\T
[V][#&] getsessionnum Function C:\TT_System\SetupFiles\Multcharts_64bt\T ~
<« " »

Total: 101 Selected: 101

[oeat ] [(Goert |

Compile on import
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Click on ‘YES’ to confirm the overwrite of existing files.

Study Type
[¥] Function 94 {34) [¥] Indicator 5 (5) [¥] Signal 2 (2)
Select script(s) to import:
Name Type Archive File &
V] [#& iaranaa Eunctinn  CATT Qustam)SatunEilac\Mutichads E4bit\T|
[V][£]avg| PowerLanguage Editor | | sabitn| = |
V] [Alavgf _64bit\T
[VI[£lbam _64bit\T
[V [#E che: Read-only studies will be overridden the following . 64bit\T
V][ clea ; !"\ studies in order te provide data consistency: S4bit\T
V] [&cou : 64bit\T
= averagetruerange (Function) k-
| Al date avg (Function) _Sdb.rt\\.T
extremevalues (Function) -64b"l‘T
. highestvalue (Function) _64bit\T
V] [Elextrg lowestvalue (Functicn) _64bit\T
V] [£]tailo sum (Function) e T
V] (& failo . . . _64bit\T
V] Elfixed] Click "Yes" if you want to proceed or "No" if you want cancel. 64bit\T
%] gapf _64bit\T
/| £l getn _64bit\T
V]l gein ve || Mo _64bit\T
] [A]getn _64bit\T
(¥ ge!ni\ TS TONCHoT TN T Iy SENTIOEupTIes \mumuluu)s_&bn\T
[#] getsessextremes Function CATT_System‘\SetupFiles\Multicharts_64bit\T
[V][£] getsessionnum Function CATT_System‘\SetupFiles\Multicharts_64bit\T ~
< [ »
{ Select Al ] [ Clear Al Total: 101 Selected: 101

Close the Power Language Editor once complete.

Page 15 of 24
r131212



@Training—ﬂfad@r S Installation Manual

5. Configure for LMAX account

Multicharts can be setup to use a number of different data feeds, the following section shows
how to configure for the LMAX data feed.

Double click on the ‘Multicharts Quote Manager’ icon on the desktop or run the ‘Quote
Manager’ from the start menu.

>

MultiChart...

MultiChart...
QuoteMan...

—
&
itiCharts...
erLang...
ultiChart...
Optimiz.

M
P

M .
ED) -
2 !

MultiChart...
Portfolio B...

HP

LightScribe Direct Disc Labeling
Maintenance Training Traders
Microsoft Office

Microseft Office Tools Documents
Microsoft SQL Server 2005

Microsoft SQL Server 2008 Pictures
Microsoft Visual Studio 2008
Microsoft Windows SDK v6.0A

Microsoft Works

Music
Morilla Firefox e
MultiCharts LMAX
MultiChartst4

gj 3D Optimization Charts
| Logs

€ MultiChartz64

## | Portfolio Backtester

] Powerlanguage Editor Default Programs
& QuickHelp

<a-| QuoteManager Halp and Support

Computer

Control Panel

Devices and Printers

IS
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Go to the ‘Tools’ menu and click on ‘Data Sources’.
There will be a delay of a few seconds before it starts.

Symbol Dictionary... Ctris T

Session Templates... Crrl=S
Exchanges & ECNs... Ctri+ X
=% All Symbols [G5] Deata Sources... Ctri+D
- Forex (22) 6) ¢ Holidays... Ctrl+H
FORE"’" (221 654 Expiration Rules... Ctri+ U
: Flmér;; "(ﬁ:} AB #F Russell 2000 E-mini Futures - Globex
: CEC (3}' AMD ADVANCED MICRO DEVICES INC
- CME (13) AR
- COMX 1) AUD/RY
- NYME (4) AUD/NZD
LNVt my AUD/USD

When Data Sources has started, scroll down the list and click on LMAX and click on
‘Settings’.

inese Futures - Globex CME Futures eSianal Off

is Data Sources =
€
V! ————
ol Name Abbr  Status Version vendor File name - Deactivate |
al Free Quotes F Active 2.0.5622.401 MutiCharts tsFreeData"eed.dll Delete )
4 GlobalServer GS Active 1.0.5622.401 MdtiCharts tsGSDataFeed.dl )
« Interactive Brokers 1B Actve 1.0.5622,401 MutiCharts tsIBDataFeed.dll E Edit..
d IQFeed IQ Active 1.0.5622.401 MutiCharts tsIQDataFeed.dll 5 - g
; | IWBank QuickTrade IWB  Active 1.0.0.1 MutiCharts  TWBankProxy.dll Clone... |
LMAX M Active 1.0.0.1 MultiCharts LMAXDataFeedProxy.dil
i MB Trading MB Active 1.0.5622.401 MultiCharts tsMBDataFeed.dl Settings... J
1) Metastock MS Active  1.0.5622,401 MutiCharts tsMSDataFeed.dl X
bl « 1 3
ti
! Description
ol
il LMAX DataFeed for MultiCharts
o
"
¢
4
4 Close |
1 |E
\ J
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Enter your LMAX account details and click on ‘OK’

otes F Active 2.0.5622,401 MultiCharts tsFreeDataFeed.dll [—
Delete
rver 3 l % « ele
ve| LMAX Data Feed Configuration ‘
Edit..
Qui Connection: Demo b ] Clone.
ng URL: https://testapi Imaxtrader.com ettings
=3 Login:
-
— Password:
on
latz OK ] [ Cancel ]
A >

Click on ‘Close’ to close Data Sources

sangseFutures-Globex CME  Futures  eSignal  Off

riss| Data Sources =
556 o i o
WA 3
yb Name Abbr  Status Version Vendor File name ~ Deactivate
in Free Quotes F ctive 2.0.5622.401 MultiCharts tsFreeDataFeed.dll [7[)1”7
ud GlobalServer GS 1.0.5622.401 MultiCharts tsGSDataFeed.dll —_—
5C Interactive Brokers 1B 1.0.5622.401 MultiCharts tsIBDataFeed.dll E T
e IQFeed 1Q 1.0.5622.401 MultiCharts tsIQDataFeed.dll

IWBank QuickTrade IWB  Active 1.0.0.1 MultiCharts  IWBankProxy.dll Clone... |
® LMAX ™ Active 1.0.0.1 MultiCharts LMAXDataFeedProxy.dll = - 5
ed MB Trading MB Active 1.0.5622.401 MultiCharts tsMBDataFeed.dll Settings...
ild Metastock MS Active  1.0.5622.401 Mulp'Charts tsMSDataFeed.dll X
plo] 4 m »
sati

Description
sol -
TE LMAX DataFeed for MultiCharts
an
EEL
iffg
mi
5 Close

\ y
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6. Multicharts configuration

Start Multicharts by double clicking on the desktop icon

When the ‘Data Server Mode’ window appears make sure the ‘Download missing historical
data’ option is ticked.

™
n

7
Data Server Mode

Online: Load the locally stored data and
connect to a real-time data feed

¥ Download missing historical data

Offline: Use only the localy stored data

|| Show Data Server Mode dalog box on startup

OK
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When Multicharts is first run it displays default workspaces (charts) the next couple of steps
remove those and set Multicharts to load the Training Traders workspace on startup.

44 r ) dndke pace | Stocks Demo Workspace
SEiLxxXliM/BIATOOCS 3 ¢

Right click on either of the workspace tabs at the bottom of the screen (‘Indicies Demo
Workspace’ or ‘Stocks Demo Workspace’) and select ‘Close All Workspaces’ from the menu.

Ctrl+ 5

[X] Ketner Channe! (close, 2 692.7 Save As., Ctrl + Shift + S

Rename Ctd + F2

ip—— Fl
Clase All Workspaces >
Go to Previous Ctrl « Page Up

» |

Type & symbol/interval » () n: is 1117|

Close The Cumrent Workspace
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Click on ‘No’ so that the workspaces are not saved.

‘You are about to close the workspace: Stocks Demo
Workspace.
Do you want to save the changes?

| Do not ask me again

[ Yes J [ No ’ [ Cancel

Go to the ‘File’ menu and click on ‘Preferences’

m View Help

. v e 2[R | 5| @3] e
. L] Open Workspace... Ctl+0
: =
3 Cle } = f
: =7 y -
e trl - i e
| e r s + Shift «
Paste ndo trl = Shift +
Broker Profiles »
= 'lh!l---.

Run Wizard..
Recent Workspaces »

Exit Alt = F4
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Click on ‘Open all workspaces from previous session’ then click on ‘OK’

Preferences (2] = |

| Workspaces | Data Server Mode | Appearance | Manual Trading|

[V Open Workspaces on Start
Show the dialog

Specify the workspaces you would like to open

Open last active workspace from previous session
en all workspaces from previous session
Open prebuilt workspaces

|| Do not show "Save Workspace” dialog on Exit

Windows Deleting
["]Do not prompt for confirmation when I want to close a window
Wizard Options

Run Wizard on Startup

oK |[ cancel |

Go to the ‘File’ menu and click on ‘Open Workspace’

Broker Profiles 4

i;,g Preferences...

Keybeard Shortcuts...

Run Wizard...

Recent Workspaces >

Exit Alt - F4
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Go to the ‘C:\TT_System’ folder and click on the appropriate file (‘“TT_LongTerm v3’ or
“TT_ShortTerm_v3’).

(L Open
s"’ ,‘V[ » Computer » COMPAQ (C:) » TT_System »
‘ Organize v New folder
| Documents ' Name 2 Date
»' Music :
: SetupFiles
&=| Pictures
p TT_LongTerm_v3
S Videos
TT_ShertTerm_v3

‘& Computer
s COMPAQ (C:)

_Backup
PerfLogs
Program Files
Program Files (
Store
SWSETUP
TT_System

The workspace will open. The first time the workspace is run it will take several minutes
(allow 20 minutes or so) for the historical data to load. Data is loaded for the past 20 days
and stored, so the next time you start the charts will be up and running much quicker.

1 MultiChartsbs - TT_ShortTem v3

5450
1.29290
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The ‘Data Window’ of the left side of the screen is not needed and can be removed from the

workspace by clicking on the ‘X’ in the top right corner.

L it rorer N

Fa el

i

x @ Interactive Brokers | @ Rithmic01l | @ Zen<ire

Q [Market &

%8| Real-Time Market Scanne
Instxlment- Resolutio

- AUD
AUD/IPY

AUD/NZD

Once the data is loaded the indicators will be shown on the charts.

eyLines_v3 (3, 10, green, red, 4, green, red, yek

EBR
X Tk

e
1.5862

100 Ticks 86.470
100 Ticks 1.25780
100 Ticks  1.04740
100 Ticks  1.23190
100 Ticks 1.53130

1.5860
1.5058

1.53130
1.58540
1.50020
131.977
1.92610
1.60390
0.81000

100 Ticks 0.98850
100 Tiks  0.93540
USD/PY 100 Tiks  82.287
EUR/USD 100 Tiks 129030

100 ks 1.60390  0.0012

100 Tiks 0.83280

07:44:41 08:08:56 082847 084921 09:0858

TT_ShortTerm_v3
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